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COVER SHEET 

Risponsihle Agency': U.S. Air Force 

Action: Headquarters Air ~mbat Coimnand (HQ J\CC) bas established Adniinistnl :iye Record (AR) 
files at ACC iMaDations. The AR files were prepared ·in accordance with the requir~ under the 
Comprehensive EnviroiJIDeOtal Response, Compensation, and Liability Act (CERCLl~), as ~ed by 
the Superfund Ameodmeots and Reauthorization At;t: (SARA). The index is a list ng of documents 
contained in the AR. · 

The AR is compiled as work on the Environmental Restoration Program (ERP) sit.:.s progress, e.od it 
· shows the basis for the selection for a response action· 'IbC AR also Serves as a vehicle fur public 
participation since a copy of the record is legally required to be available for p:.tblic review at a 

. repository at or near the site. 

Purpose and Need: To provide administrative support for the ERP at ACC installf·tions and to meet 
the policies detailed by Air Staff in their Jetter of 12 Jan 88. Section 113(k) ofCER~LA, as .amended 
by SARA, requires the development and retention of docUIIJmtati.on for ERP sites at which a response 
action is p~ed or ongoing. Executive Order 12580 delegates to the Secreta!,¥ of Defense the 
responsibility tor establishiog this AR file for Department ofDefense sites. The Ofike of Solid Waste 
and Emergency Response (OSWER) Directive 9833.1 3A·l requires that the AR file be · a printed 
docwnent. The AR serves two primary purposes: the record establishes the docnnentazy basis for 
selection of a response action for each site, afld the record ensures public participatio.r l in the process of 
response seled:i.on. 

1be AR index provides a listing of documents relevant to the decision process for a response action 
and public participatio·n in the process. 

For furlher infonnation contad: Ms Carol Stark, HQ ACCJCEVR, Langley AFB, VA, at DSN 574~ 
9431 or COtvfM 757-764-943'!. 
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USING THE AR/IR FILE ON CD-ROM 

1. WELCOME 

Welcome to the Cannon Air Force Base (AFB) Administrative Record (AR) File on CD­
ROM (Compact Disk Read Only Memory). This set of three CD-ROMs contains images of 
all installation restoration program documents in the AR file (through 1997) and the 
applications needed to search and view the images. With this information, you can perform 
detailed searches of the AR textbase to identifY specific documents, and then view the 
selected documents page-by-page or print selected document pages. For further information 
on the AR file, contact the Cannon Environmental Restoration office at (505) 784-6378or by 
fax at (505) 784-1093. These instructions have been developed to walk you through the 
step-by-step approach of retrieving and viewing the selected documents. 

2. THE ADMINISTRATIVE RECORD 

An initiative to establish AR files at each of the installations was performed by the U.S. Air 
Force Headquarters Air Combat Command (HQ ACC) during 1992-1994. The initiative was 
coordinated through the Headquarters Environmental Protection Agency (HQ EPA), EPA 
regional offices, state regulatory offices, Secretary of the Air Force offices, Air Staff, HQ 
ACC, and base organizations. This initiative standardized the AR files at each ACC 
installation, and also created and standardized an information repository (IR) file (a copy 
provided for public review) for each base. During that time, the HQ ACC Legal office 
developed ACC guidance detailing specific types of documentation that would be considered 
and incorporated into the AR file. This guidance parallels the EPA's Office of Solid Waste 
and Emergency Response (OSWER) Directive 9833.3A-1, "Final Guidance on ARs for 
Selecting CERCLA Response Actions". 

The ACC guidance provides for an AR file that is the collection of all documents used to 
support the decision for selecting response actions at an ACC installation. Both the AR and 
IR files are updated as new documentation is made available, until all of the final response 
decisions have been made for remediating sites on an installation. 

To manage the documents, HQ ACC developed an AR textbase consisting of 30 datafields 
using INMAGIC® DB/TextWorks™ software. This software allows the user to execute 
detailed searches on the AR datafields to select documents of interest. The runtime version of 
this software, DB/Search Works™, is included with the CD-ROM set (on CD Volume 1). 
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Because of the large quantity of documents comprising the ARJIR files, storage at libraries is 
becoming an issue for many U.S. Air Force installations. To remedy the storage problem, HQ 
ACC implemented an initiative to scan ACC installations' AR files onto CD-ROM. HQ EPA 
approved use of this technology as an alternative to maintaining a hard copy of the IR. 
Cannon AFB is one of the ACC installations using this technology. 

3. BEFOREYOUSTART 

To view and print documents from the ARJIR file on CD-ROM, the computer you are using 
must have the CD Image Retrieval software installed on the hard drive. If you do not find a 
program group and icons for the CD Image Retrieval software on the Windows 3.1 desktop 
or in the Start/Program menu in Windows 95/98/NT, you will first need to install this viewer 
from Volume 2 ofthe CD-ROM set. 

4. INSTRUCTIONS FOR LOADING THE KODAK CD IMAGE RETRIEVAL 
SOFTWARE 

2 

a. Place CD Volume 2 in the CD-ROM drive of the computer you are using. 

b. In Windows 3.1, choose Run from the Program Manager File menu. For 
Windows 95/98/NT, click on the Start button and select Run. 

c. When the Run window appears, type in d:\app_spec\cdimg\setup.exe, where dis 
the drive letter for the CD-ROM drive on your computer, and select OK. 

Qpen: 

Type the name a a program, fok:ler, doct.ment, or Internet 
resot.~ee. and \lll'ldows wi open ~ for you. 

• 

OK I r:s 
Cancel I llrowse ... 
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d. The CD Image Retrieval screen will be displayed. Review the information in the 
window and then choose Continue. 

CD Image Rehieval EJ 

Welcome to the CD Image Retrieval Setup 
program. 

Thi$ program will $etup your PC to run the CD 
Image Retrieval application. You may choose to 
either run the application from the CD or from a 
local copy of the application which this program will 
create for you on your hard disk. 

This program will also create a program group for 
CD Image Retrieval. 

jr.,.or.tinUe·Jt 
~-~--- ---· 

e. The Set Windows Path screen is displayed. The Path edit field specifies the full 
path of your Windows directory. Choose Continue to use the Windows directory 
shown. 

Set Wmdows Path EJ 
- ---~~~-~--~~-~-~~~~~--- --- -~ 

The setup program will copy some files into 
the Windows directory. Enter the path of 
your Windows directory below. 
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f. The Set Destination window is displayed. It displays the directory where the 
application will be installed. Under Installation Options, select the Install 
Application and System Files on Local Disk button. 

Set Destination EJ 
-- -- I 

You ma)l choose to install the application locaii.P or to instal oni.P the 
necessary system files and run the application from the CD. Running 
on a local disk will improve the application's performance. 

In either case. the application's error log will be kept in the location 

I entered below. 

[ lnstallo: 
C:\CDINAGE lr Set Location I I 

r Installation 0 ptions: 

r. Install APplication and S.Pstem Files on local Disk 
I 

r Install ystem Files Dni.P 

lnatallation Drive: C: 
Space Required: 13761( 

I 

Space Available: 3518081( 

I 
~-----rriiiaJr--·----~1 r bit --1 11 Help I I 

1 li"l"i"illilli •ii lii"lllillilii""""""IJ. 

g. If you want to change the directory where the application will be installed, select 
Set Location (the default path typically is the most appropriate). The Set 
Destination Path window will appear. Enter the appropriate path and choose 
Continue. 

The aotup program will copy CO Image 
Retrieval files into the following directory. 

Path: IC:\CDINAGEI 
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h. The Set Destination window will be redisplayed. Select Install from the Set 
Destination window. 

---

Set Destination EJ 
I 

You ma)' choose to install the application locall)' or to install onl)' the 

I 
necessary system files and run the application from the CD. Running 
on a local disk will improve the application's performance. 

In either case. the application's error log will be kept in the location 
I 

entered below. 

[""··to: C:\CDIMAGE lr ·s.:in;; .. ;; .. itr··········1) ·•······ .. ~ . . ml ...... I 
- I nslallation 0 ptions: 

l- Install ~plication and s,stem Files on local Disk 

{ Install ~stem Files Onl)' 

i 
I 

Installation Drive: C: 
Space Required: 1376 K I 

Space Available: 351808 K 

r install I r .E.xil -1 If Help ., 
I 

i. The Set CD-ROM Drive screen is displayed. Enter the drive letter designating the 
CD-ROM drive on your computer (for example, D), then choose Continue. 

Set CO -ROM Duve EJ 
---~ -~-- - - ----~~ 

Enter the drive letter designating 
the CD-ROM drive on your S)'stem. 

CD-ROM Drive: ~ 
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j. The next series of screens shows the setup program copying the appropriate 
application files from the CD-ROM to your hard drive. When the installation is 
complete, the CD Image Retrieval program group and icons are created and the 
Setup Complete message window is displayed. Choose OK to exit the setup 
program. 

Setup Complete £) 
----------- ----

Setup Successful! 

5. SEARCHING THE AR/IR FILE TEXTBASE 

Searching is the process of finding information in the textbase. A search is a request to find 
all of the records that match specific requirements. By using the INMAGIC® 
DB/SearchWorks™ software, you will be able to search your textbase on any field or 
combination of fields, sort the results by the field of your choice, and output a report using 
one of five pre-designed formats that have been provided. You will run the 
DB/Search Works™ software directly from Volume 1 of the CD-ROM set, and must not 
remove this CD from the CD-ROM drive ofyour computer until you close the software (see 
section 5.2 for instructions on closing DB/Search Works™). 

5.1 Starting the DB/SearchWorks™ Software 

6 

a. Place CD Volume 1 in the CD-ROM drive of your computer. 

b. In Windows 3.1, choose Run from the Program Manager File menu. For 
Windows 95/98/NT, click on the Start button and select Run. 
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c. At the Run window, type in d:\adminrec\cannon\dbsgsrch.exe, where d is the 
drive letter for the CD-ROM drive on your computer, and select OK. 

Type the name ol a program. folder. doct.mert. or Internet 
resot.rce, and \1/ndows wl open it for you. 

d. The DB/SearchWorks™ 2.1 Run-time window will be displayed. Choose Open 
from the File menu. (Ifthis is the first time DB/SearchWorks™ has been used on 
this computer, you will get the User File Path window with a default path of 
c: \windows in the selection box. Select OK.) 

User Preferences. .. 
Cuttomize IocbaR ... 

Al+F4 

1 F:\ADMINAEC\AVONPAAK\AVONPAAK 
~ D:\clltext\amc\travis\ TRAVIS 
J F:\ADMINAEC\BEALE\BEALE 
~ 0:\clltext\test\newtrav\newtrav 
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e. The Open Inmagic DB/TextWorks Textbase window appears. Select cannon.tba 
from the resulting dialog box then select OK to open the Cannon AFB ARIIR 
text base. 

Ust filet of p: 

folders: 
f:\adminrec\cannon 

127 f:\ 
1:2:7 adminrec 

~cannon 
CJ toe 

D~: 

liZ! F: 

f. The Query by Example (QBE) window will now be on your screen. Each box on 
the QBE screen represents a field you can search. 

Fl LOC 

AND)~------------------------~ 
TYPE 

~01~------------------------~ 
QUAL 

~01~----------------------~ 
DATE 

~01~------------------------~ 
REC DATE 

~01~--------------------------~ 
SU Tl 

~01~------------------------~ 
AU 
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5.2 Closing the DB/Search Works™ Software 

You can close your DB/SearchWorks™ session at any time by choosing Exit from the File 
menu. Be sure to leave CD volume 1 in the CD-ROM drive of your computer while closing, 
then remove the CD when the software is closed. You must exit the software before using 
the CD Image Retrieval software to view ARIIR file documents. 

5.3 Developing a Search Strategy 

The first- and most important- step in any search is to develop a search strategy. To 
do this, you must identify the objective of your search: What are you looking for, and how do 
you want the results presented? If you are preparing a report based on the search results, 
how much data from the index do you want to display? 

There are 30 fields in the textbase providing a variety of information about each ARIIR file 
document. The field labels, field names, and a brief description of each field are provided 
below, in the order they appear in the QBE window. 

• FILE_NUM (ARIIR File Number): The unique identifier for each document. 

• IRP _FL (IRP File Number): The Air Force Record Information Management 
System (RIMS) generated file code from the installation's file plan. 

• FL_LOC (File Location): The location of the document. 

~. TYPE (Document Type): Description ofthe document type, such as plan, 
correspondence, memorandum, etc. 

• QUAL (Document Qualifier): Description of document quality or status. 

/ • DATE (Document Date): The date ofthe document. 

• REC_DATE (Receipt Date): The date the document was received at the 
environmental office. 

• SU/TI (Subject/Title): The title or subject of the document. 

• AU (Author): Name ofthe individual(s) author. 

• AU_AFF (Author Affiliation): The organization or agency with whom the author 
is affiliated. 

• CORP _AU (Corporate Author): The name of a company or agency author. 

• RECIP (Recipient): Name of the document recipient. 

• RECIP _AFF (Recipient Affiliation): The organization or agency with whom the 
recipient is affiliated. 

• ATTCHMT (Attachment): Description ofthe attachments to a document. 

• COPY_TO (Copy To): Name ofperson or agency receiving a copy ofthe 
document. 
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• KEYWORD (Keyword/Environmental Resource): The environmental resource 
affected, or other keywords. 

• NOTES (Notes): Additional information about the document. 

\..../" • SITE_NUM (Site Number/Name): The IRP site number and name. 

• HAZ_CONTAM (Hazard/Contaminant): The hazard or contaminant discussed in 
the document. 

• EPA_FILE_NUM (EPA File Number): File code referencing EPA's file 
structure. 

• OU (Operable Unit Name or Number): The name or number of the IRP operable 
unit. 

• PROJ_NUMBER (Project Number): The USAF-assigned project number for 
contracts. 

• ROD_DATE (Record ofDecision Date): The date of a final record of decision. 

• DATE_ENT (Date Record Entered): The date the record was entered into the 
AR textbase. 

• DATE_MOD (Date Record Modified): The date the record was modified in the 
AR textbase. 

• EPA_REGN (EPA Region Number): The EPA region where the installation is 
located. 

• INST _CODE (Installation Code): The unique three letter identifier for the 
installation. 

• INST_NAME (Installation Name): The installation name and state where located. 

• MAJCOM (Major Command): The major command to which the installation 
belongs. 

• PR_DA (Privacy Data): This field references any Privacy Act information in the 
document. 

Use the most logical textbase field for your search. For example, if you are searching for 
TCE, a contaminant, use the HAZARD_ CONTAMINANT field for your search, rather than 
the SUBJECT_ TITLE field. If you are searching for site information, use the SITE_ NUM 
field. 

5.4 Using Boolean Operators 

Before we go any further in our discussion of searching, let's talk about search ''theory." You 
will use tools called Boolean operators- AND, OR, NOT- to expand and limit searches. 

Suppose you are looking for a document that pertains to Site FT -06 and was written by the 
EPA. The AND operator limits the search to those documents that are both about Site FT -06 
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and from EPA. Documents that are about Site FT -06 but not from EPA, and documents 
from EPA that do not pertain to Site FT -06, are excluded from the findings. Only documents 
that meet both criteria will be included. This is probably the most common type of search 
you will use. 

Perhaps you need to find all documents that pertain to Site FT -06, from all sources, as well as 
all other documents from EPA. The use of the OR operator expands the search. Findings 
will include all documents that meet either criterion. As you can see, this will result in a 
much larger set of search findings. 

Perhaps you need to search for all documents pertaining to Site FT -06 except those from 
EPA. The use of NOT limits the search in a different way than the use of AND. The findings 
would include only those Site FT -06 documents that meet both criteria - about Site FT -06 
but not from EPA. In other words, the FT -06 documents from EPA would be excluded from 
the search findings. 

5.5 Understanding the Browse Feature 

The Browse function is one ofthe most useful features ofDB/SearchWorks™, allowing you 
to examine the actual contents of each indexed field during the search process; thus, 
eliminating the guesswork in searching. You can paste items from the lists into the QBE 
boxes to search for documents to which these criteria pertain. Pasting is recommended 
because it is more accurate, and often quicker, than typing. By pasting a word or term, you 
guarantee that it matches information in the text base. Otherwise, if your datafield entry is not 
in the correct format, it may not be recognized by the query. 
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While in the QBE form, you can browse through the entries in a given field either as terms or 
words. To browse, place the cursor in the box for the field you wish to browse, and click on 
the Browse icon or press F3. Terms appear in the Browser dialog box. For example, the 
following screen illustrates the query choices available for pasting in the Type datafield. 

Query Cho1ces Browser· TYPE EJ 

1 Fact Sheet 
1 Index 
17 Meeting Agenda Minutes 
7 Memorandum 
80 Plan 
3 Preu Release 
37 Record of Decision ROD 
138 Report 

---:-• "~·-· 

F"JIIId: 1 TYPE========-'rt!] 

The number at the beginning of each line indicates the number of records that contain the 
word or term shown. You can paste terms or words into the QBE form by double-clicking 
the selection or clicking Paste. 

5.6 Finding Records 

After determining your search strategy, you are ready to begin searching the textbase. When 
you open the textbase, you see the QBE window. Each box on the screen represents a field 
that you can search. There are two basic techniques that you can use to find records: 

• Typing the information required in one or more field boxes, or 

• Using the Browse feature (the Eyeball button from the toolbar row) to select 
words or terms. 

To find records that satisfy multiple conditions, type or paste information in two or more 
boxes, then toggle the Boolean operator button in front of a box (AND, OR, NOT) to 
determine how the result of the search in that box is combined with boxes already evaluated. 
To toggle a Boolean operator button, click the button with the mouse or tab to a button and 
use the spacebar. 
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For example, let's find all documents related to FT-06, written after 1997, which are not 
correspondence. Start the search at the QBE screen. 

AU AFF 

~ol~-------------------------­
coRP AU 

~ol '---------------..... 
REOP 

~ol '--------------_..... 
REOP AFF 

~oi~--------------------------­
ArratMT 

~ Mol~------------------------~­
copv TO 

~D)~--------------------------­
KEYWORD 

w~ol~------------------------~ 
NOTES 

r~ol .____ ___________ __..... 
SITE HUM 

The first criteria (FT -06) can be pasted in the SITE_ NUM field box by using the browse 
function. Place the curser in the SITE_ NUM field box and select the Eyeball icon on the 
toolbar or press F3 to browse. 

HAl COHTAII'I 

~ol '---------------...., 
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The Query Choices Browser for SITE_ NUM will appear. Select FT -06 from the list and 
choose Paste, then Close. 

find: 
~~~P-·~K======~==N~u-m~Oi-r~~~e~~~·==~~~~--~~ 
21 AOC-36 Rubble Pile ~~~-
14 AOC-D Nonfriable Asbestos Burial Pit 
4 AOC-E Bore Site Wound 
4 AOC-F Diapocal Pit 
7 AOC-G Potential Old Landfill 
7 AOC-H Potential Old Landfill 
119 DP-16 Solvent Di•poso~~l Site 
42 DP-33 Dis osal Pit 

Help--- I 
:W.orda Liat 1 field: I SITE_N_Ut.t--=====-- Ei1 

The second criteria (documents after 1997) can be typed in the DATE field box. In this case, 
documents after 1997 are identified by using the search item >1997. Place the curser in the 
DATE field box and type > 1997. 
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The third criteria (documents that are not correspondence) can be pasted in the TYPE field 
box using the Browse function. Place the curser in the TYPE field box and select the Eyeball 
icon on the toolbar or press F3 to browse. The Query Choices Browser for TYPE will 
appear. Select Correspondence from the list and choose Paste, then Close. 

Que1y Choices 810wse1 TYPE EJ 

1 Data 
1 Fact Sheet 
1 Index 
17 Meeting Agenda Minutes 
7 Memorandum 
80 Plan 
3 Press Release 
37 Record of Decision ROD 
138 Report 

Next, click on the Boolean operator box for the TYPE field until the operator becomes 
NOT to exclude documents that are correspondence from the search (according to our 
search criteria). 

FILE NUIII ANDI L___ ___________ ____:,w 

IRP FL 

[ANolL-------------------------~ 
FL LOC 

~oiL-------------------------~ 
TYPE 

1
iiiiQ:.TIII-correspondence 
~QUAL 
ANDIL-------------------------~ 

UAit 

ANDI L.:.l>.:.:::199~7--------------~ 
RFC: OATF ANDIL_ ________________________ ~ 
SU Tl 
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To execute the query, just click the Go button on the QBE toolbar or choose Execute Query 
from the Search menu. 

FL LOC 

ANDI '---------------~ 
TYPE 

NOTII=eattespondence 

QU.I\l 
ANDI ._____ ____________ ...... 

DATE 
ANDII>t997 

After executing the query, a DB/Search Works™ message window appears reporting how 
many records met your search criteria. If there is a match, you can view them in the report 
window by selecting Yes. 

lnmagic OB/SearchW'orks Message f!3 

Query fcMn:l6 recorcll. D. 
Do you want to view them in the AdPort window? 
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At any point in the query process, you can clear all the fields and enter new search criteria by 
clicking the New Query button on the QBE toolbar or choosing New Query from the 
Search menu. 

lYPE 
NOTjl-correspondenc~ 

QUAL 

1 ~~~-----------------------w 
DATE 
1>1997 

6. VIEWING AND PRINTING REPORTS 

6.1 Formatted Reports 

After retrieving a set of records from your query, you can view and print a report of your 
results in a variety of defined formats. The five available report formats were developed to 
meet the needs ofU.S. Air Force personnel and members of the public interested in viewing 
AR file documents. These report formats are: 

• the ImageNum format, 

• the EP Alndex format, 

• the Longlist format, 

• the Shortlst format, and 

• the Sitelst format. 
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All the reports provide basic identifYing information about each AR file document, including 
the AR file number, subject/title, author, and document date. For the purpose of selecting AR 
file documents to view, the ImageNum report will be most useful as it also identifies which 
volume of the CD-ROM set holds the AR file documents you want to view. A sample 
ImageNum report printed for our previous query example is shown below. 

C1111non AFB, NM 
CD Vol..- 1111cl AR/IR File Nlllllber Report 

Date or Report: 6128199 

CD AR/IRFIIe Aatboror 
Volume Number Title or Subject Corporate Author Document Date 

01 Administrative Record File Index LABAT-ANDERSON 08 Jun 98 
INCORPORATED 

229 Management Action Plan Radian Corp. Dec97 

4 361 RAB Meeting Minutes, 15 May 97 27CESICEVR 29Jul97 

4 365 RAB Meeting Minutes, 14 Aug 97 27CESICEVR 14Aug97 

4 367 Final Report for Naturally Occurring Concen1rations W oodward-Ciyde Consultants Sep97 
of inorganic and Background Concen1rations of 
Pesticides 

393 RAB Meeting Minutes, 08 Jan 98 27CES/CEVR 08 Jan 98 

6.2 Selecting Report Forms 

• Choose Select Forms from the Display menu. The following window appears. 

01( I I 

The Basic Record form ahowa each field in lhe 
leoclbase. <.U~ generated> 

inported from INMAGICIDOS fie SITELST .FMO 
(Created: 711198 8:42:58 AM) 

inporled from INMAGICIOOS fie SITELST.FMO 
(Created: 711198 8:42:58 AM) 

u..-. ... 

• To select a form for a particular operation, click one of the three buttons: Record 
Display, Report Window, or Report Printing. 
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• A dialog box displays the forms available for that operation. The basic report form 
provided by DB/Search Works™ is listed first, and then the forms designed 
specifically for AR file documents are listed alphabetically. The form currently in 
use is highlighted in the dialog box. 

Selection: 
Created: 
Description 

IMAGENUM 
711198 8:42:58 AM 
inported from INMAGICIOOS file SITELST.FMO 

H,elp ... 

• Select a form or click Revert to Default to assign the textbase default form for 
the operation identified in the title bar of the dialog box (the default form for the 
Report Window and Report Printing has been set to ImageNum ). Then click 
OK. 

6.3 Printing a Report 

When you have selected your preferred forms and executed a query, you are ready to print a 
report. 

U' Note the default report, ImageNum, includes the CD-ROM volume and ARIIR file 
number for each record in your query. You will need this information to view ARIIR 
file documents. 

There are two ways start a print report. 
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• Click the Print icon on the toolbar, or 

4 365 RAB Meeting Minutes, 14 Aug 97 

4 367 Final Report for Naturally Occurring Concentrations 
of Inorganic and Background Concentrations of 
Pesticides 

5 393 RAB Meeting Minutes, 08 Jan 98 

• Choose Print from the File menu. 

5 

User P!e(eriii"'CM. .. 
CUIIcmize !~ .. 

1 F:\ADMINREC\CANNON\CANNON 
.2 F:V.OMINRECI.MOOOYI.MOODV 
.J F:\AOt.IINREC\MINOT\IoiiNOT 

for Naturally Occurring Concentrations 
and Background Concentrations of 

J F:\AOt.IINREC'IA\IONPAAK\AVONPARK 

393 RAB Meeting Minutes, 08 Jan 98 

LABAT-ANDERSON 
INCORPORATED 

Radian Corp. 

l7CESICEVR 

Woodward-Clyde Consultants 

'l7CES/CEVR 

!.,ABA 
INCORPORATED 

Radian Corp. 

27 CES/CEVR 

Woodward-Clyde Consultants 

27 CES/CEVR 
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7. VIEWING DOCUMENTS WITH THE KODAK CD IMAGE RETRIEVAL 
SOFTWARE 

The following instructions will guide you through retrieving, viewing, and printing ARIIR file 
documents. Detailed instructions for using all the features of the CD Image Retrieval 
software are available in the application's on-line help menu. 

You must exit the DB/SearchWorks™ software before using the CD Image Retrieval 
software to view ARIIR file documents. If DB/Search Works™ is not closed, choose Exit 
from its File menu. Be sure to leave CD volume 1 in the CD-ROM drive of your computer 
while closing, then remove the CD when the software is closed. 

a. Place the CD volume containing the document you wish to view into the CD­
ROM drive. (Reference the ImageNum report you created in DB/Search Works™ 
for the CD volume and ARIIR file number information you will need to view 
documents.) 

CaDDon AFB, NM 
CD VollUM ud ARIIR File Nnmller Report 

Date of Report: 6128199 

CD ARIIRFUe A•thoror 
vow- Namber 

01 

229 

4 361 

4 365 

4 367 

393 

U' 

TttJe or S•bJect Corporllte Aathor DoCllment Date 

Administrative Record File Index LABAT-ANDERSON 08 Jun 98 
INCORPORATED 

Manasement Action Plan Radian Corp. Dcc97 

RAB Meeting Minutes, 15 May 97 27CES/CEVR 29 Jul97 

RAB Meeting Minutes, 14 Aug 97 27CES/CEVR 14Aug97 

Final Report for Naturally Occwring Cooccntratioos Woodward-Clyde Consultants Sep97 
of inorganic and Background Concentrations of 
Pesticides 

RAB Meeting Minutes, 08 Jan 98 27CES/CEVR 08 Jan 98 

Note ARIIR file number 1 is an index of the entire textbase for Cannon 
AFB, therefore the information in this document can be accessed by 
selecting all documents during your DB/SearchWorks™ query. You will 
not be able to view ARIIR file number 1 with the CD Image Retrieval 
software, and will not use CD Volume 1 for document viewing. 
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b. From the CD Image Retrieval Program Group on your Windows 3.1 desktop 
or the Start/Programs/CD Image Retrieval menu on Windows 95/98/NT, select 
CD Image Retrieval - Local. The CD Image Retrieval software starts, the CD 
Image Retrieval window appears, and the Select Database dialog box is displayed. 
The Cannon AFB database (CANNON) will be highlighted by default. 

CANNON 

Diles;.tariea: 
f:\ 

~f:\ 
CJ APP_SPEC 
CJ ooc_co 

IIZJ '= 

c. With the CANNON database highlighted, choose OK. An empty CANNON 
window is displayed at the top of the CD Image Retrieval window. 

l!i) CD lm<~ye Retr1ev<~l CANNON .. [iii) EJ 
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d. Choose Find from the File menu, or click on the Binoculars I:!!J icon in the 
application toolbar. The Find dialog box is displayed with a blinking cursor placed 
in the field box titled AR _NUMBER. This is the only field you will use to view 
nnages. 

AR_NUMBER r OK I 
DOC_CRE_DT r Cancel I 
ooc_cRE_TM r g... I 

e. At the blinking cursor, enter the ARIIR file number for the document you want 
to view. Then select OK. (This example will use ARIIR file 361.) 

f. The document you selected is automatically opened in an image window. The 
document page count is shown in the image window title bar. Maximize the 
windows on your desktop for the best image quality. 
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g. Adjust the view as needed by Magnifying or Rotating the image using the 

options under the Image menu or by selecting the appropriate Magnify I~ I~] 
or Rotate ("- icons on the toolbar. Selecting Reset from the Image menu will fit 
a full image to you viewing window. 

h. Navigate through the document by using the options under the Page menu or by 

selecting the Previous Page/Next Page IiI i J icons on the toolbar. 

i. To view a new document, make sure the correct CD volume is in the CD-ROM 
drive for the next document you wish to view and repeat the retrieval process 
from step d (choose Find from the File menu, or click on the Binoculars icon in 
the application toolbar). 

U/ 
Note the ARIIR file number from your last search is displayed in the Find 
dialog box. You can clear this entry by choosing Clear. 

j. To print one or more pages of the document, choose Print from the File menu. 
Select the pages for printing, then choose OK. 

P~R~~----~====~~ 

r AI• 
r '.m.~~!ltt 
(i"_fagea 

[r.-: D lo: 

,Copies: 

,ietup ... 
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k. When you are done viewing documents, exit the image retrieval software by 
selecting Exit from the File menu. 

N,, llllll•...,.,•llib._.....a .. u.tt .. AI•••wr•IIIIIAI ...... R•w• 
--..----~~~~-~· .... - .. QI-
'· ,.,.....,_,IIIIIJa 

'odiiiii,C!IQ!V,IIJW9!.CMW.Q­

!l'ftul.ll 

MIHIIWWutlll'Uit211'11'1.1& 

--lill""""'" 
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